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Modeling a Toy Hammer
Some models require more attention to detail.  This is an example of a model that requires precise
modeling techniques. This exercise also requires a number of different surface creation
techniques. The technical drawing is included to help you create a very precise model.

Creating a toy hammer
1 Start a new model. Save as Hammer.

2 Create the following layers: Curve, Handle, Tang, Head, Claw.
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3 Draw the outlines for the hammer.

Drawing outlines helps while drawing the curves. You can either draw lines, polylines, or
rectangles to create the outlines.  Use the dimensions on the technical drawing to get accurate
outlines.

To create the claw:

When modeling the shape of the claw you will use circles and arcs.  You can trim the circles
and arcs and then join them together to create the closed curve.

1 Change to the Curve layer

2 Draw a curve defining the shape of the claw in the top viewport.

You can use a freeform curve or use a combination of arcs and circles which are trimmed and
joined to create the curve. Following is a step by step approach to creating the curve for the
claw part of the hammer.

Start by drawing two circles.

3 From the Curve menu, click Circle, then click Tangent to 3 Curves.

4 At the Select first curve prompt, select the curve at point one.

5 At the Select second curve prompt, select the curve at point two.
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6 At the Select third curve prompt, select the curve at point three.

The circle will be created tangent to all three curves you selected.

7 From the Curve menu, click Circle, then click Diameter.

8 At the Start of diameter (Vertical) prompt, snap to the midpoint of the upper claw
construction line.

9 At the End of diameter prompt, type .5 and press ENTER.

10 At the End of diameter prompt, pick a point directly below the first point.

To create the tangent arcs:

1 From the Curve menu, click Arc, then click Tangent, Tangent, Radius.

2 At the Select first curve for ArcTTR prompt, select a circle near the right edge.

3 At the Select second curve for ArcTTR prompt, select the other circle near the right edge.

4 At the Radius <1> prompt, type 2 and press ENTER.

5 Delete the parts of the arcs that you don’t need.

6 From the Curve menu, click Arc, then click Tangent, Tangent, Radius.

7 At the First curve prompt, select a circle near the left edge.

8 At the Second curve prompt, select the other circle near the left edge.

9 At the Radius <1> prompt, type 3  and press ENTER.
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10 Delete the parts of the arcs that you don’t need.

To trim the circles:

1 From the Edit menu, click Trim.

2 At the Select cutting edges (Options) prompt, select one of the arcs.

3 At the Select cutting edges (Options) prompt, select the other arc.

4 At the Select cutting edges (Options) prompt, press ENTER.

5 At the Select object to trim (Options) prompt, select the insides of the circles.

6 At the Select object to trim (Options) prompt, press ENTER to end the command.

7 Join the curve segments.

The command terminates when the curve closes.

To extrude the claw part of the hammer:

1 Change to the Claw layer.

2 Select the joined segments.

3 From the Surface menu, click Extrude, then click Straight.

4 At the Extrusion distance (Direction Cap=no Bothsides Tapered) prompt, type C and
press ENTER.

This makes it a solid.
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5 At the Extrusion distance (Direction Cap=yes Bothsides Tapered) prompt, type B and
press ENTER.

This extends the  extrusion on both sides of the construction plane.

6 At the Extrusion distance (Direction Cap=yes) prompt, type .75 and press ENTER.

To create slot for the claw part of the hammer:

1 Change to the Curve layer.

2 Draw a Curve in the Right viewport, that starts in the middle of the extruded object, and
extends to the right beyond the extrusion.

3 Mirror the curve.

4 Draw a Line between the end points, then Join the three curves.
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5 Select the joined segments.

6 Change to the Claw layer.

7 From the Surface menu, click Extrude, then click Straight.

8 At the Extrusion distance <.75> (Direction Cap=yes Bothsides Tapered) prompt, type B
and press ENTER.

9 At the Extrusion distance (Direction Cap=yes) prompt, type 2 and press ENTER.

10 Rotate the slot in the Top viewport

11 Save your model.

To remove the slot from the claw:

1 From the Solid menu, click Difference.
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2 At the Select surface or polysurface prompt, select the claw extrusion.

 3 At the Select surface or polysurface to subtract prompt, select the Slot extrusion.

 

4 Save your model.

To make the fillets on the claw:

1 From the Solid menu, click Fillet Edge.

2 At the Select edges to fillet ( Radius=1 ) prompt, select the top edge of the claw.

3 At the Select edges to fillet ( Radius=1 ) prompt, select the bottom edge of the claw.

4 At the Select edges to fillet ( Radius=1 ) prompt, type .1 and press ENTER.

5 At the Select edges to fillet ( Radius=0.1 ) prompt, press ENTER.

The edges have a round on them.

6 Save your model.

To create the Head:

1 Change to the Curve layer.
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2 Create the curve for the cross section of the head, using the Curve command.

 

Make sure the curve intersects the claw part.  This will make joining the two pieces easier.

3 Change to the Head layer.

4 From the Surface menu, click Revolve.

5 At the Select curve to revolve prompt, choose the polyline for the cross-section of the head.

6 At the Start of revolve axis prompt, pick the end of the curve.

7 At the End of revolve axis prompt, toggle ortho on and pick a point above the first point.
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8 In the Revolve Options dialog, click OK.

A surface is created.

9 Save your model.

To join the head and the claw:

1 From the Solid menu, click Union.

2 At the Select surface or polysurface prompt, select the Head.

 3 At the Select surface or polysurface to union prompt, select the Claw.

 

4 Save your model.

To make the fillet where the head and the claw meet:

1 From the Solid menu, click Fillet Edge.
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2 At the Select edges to fillet ( Radius=0.1 ) prompt, select the edge where the two parts join.

3 At the Select edges to fillet ( Radius=0.1 ) prompt, press ENTER.

The edge has a round on it.

4 Save your model.

To create the Tang:

1 Change to the Curve layer.

2 Create one of the curves for the tang of the hammer.

Make sure that it intersects the claw.
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3 Mirror to create the other curve.

To create the shape curve for the tang and the handle:

Create the shape curve for the tang in the right viewport. This curve will also be used for the
handle.

1 Turn on ortho.  Use the Lines command to create the curve for the tang cross-section curve.
This curve will also be used for the handle

The height of the line is .375 and the width is .75.

2 Fillet the corners with a radius of .25.

3 Join the curves

4 Select the joined curve.
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5 From the Curve menu, click Edit Tools, then click Rebuild.

Rebuilding the curve eliminates any kinks, which will make a smooth surface with fewer
potential problems later in the modeling process.

6 In the Rebuild Curve dialog, click Preview. If the geometry matches the curve, then click
OK. If the geometry doesn’t match the curve, change the point count and click Preview.

To create the surface for the tang:

1 Change to the Tang layer.

2 From the Surface menu, click Sweep 2 Rails.

3 At the Select 2 rail curves prompt, select one of the rail curves (1).

4 At the Select 2 rail curves prompt, select the other rail curve (2).

5 At the Select cross-section curves (Point) prompt, select the shape curve (3).

6 At the Select cross-section curves (Point) prompt, press ENTER.

7 In the Sweep 2 Rails Options dialog, click OK.
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A surface is created.

To finish the tang:

1 From the Transform menu, click Mirror.

2 At the Select objects to mirror prompt, choose the tang surface you created.

3 At the Start of mirror plane prompt, in the Front viewport snap to the endpoint at the lower
left corner of the tang surface.

4 At the End of mirror plane prompt, toggle ortho on and pick a point to the right in the Front
viewport.

5 Join the two surfaces together.

6 From the Solid menu, click Cap Planar Holes.

7 At the Select surfaces or polysurfaces to cap prompt, choose the tang.
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8 At the Select surfaces or polysurfaces to cap prompt, press ENTER.

9 Save your model.

To join the tang and the claw:

1 From the Solid menu, click Union.

2 At the Select surface or polysurface prompt, select the tang.

 3 At the Select surface or polysurface to union prompt, select the claw.

 

4 Save your model.

To make the fillet where the tang and the claw meet:

1 From the Solid menu, click Fillet Edge.
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2 At the Select edges to fillet ( Radius=0.1 ) prompt, select the edge where the two parts join.

3 At the Select edges to fillet ( Radius=0.1 ) prompt, press ENTER.

The edge has a round on it.

4 Save your model.

To create the Handle:

1 Change to the Curve layer.

2 Create one of the curves for the handle of the hammer.  Make it start at the endpoint of the
tang profile curve and end on the centerline.
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3 Mirror to create the other curve.

To create the surface for the handle:

1 Change to the Handle layer.

2 From the Surface menu, click Sweep 2 Rails.

3 At the Select 2 rail curves prompt, select one of the rail curves.

4 At the Select 2 rail curves prompt, select the other rail curve.

5 At the Select cross-section curves (Point) prompt, select small the curve you drew for the
tang.

This is the same curve you used to create the tang of the hammer.

6 At the Select cross-section curves (Point) prompt, press ENTER.

7 In the Sweep 2 Rails Options dialog, click OK.
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A surface is created.

To finish the handle:

1 From the Transform menu, click Mirror.

2 At the Select objects to mirror prompt, choose the surface you created.

3 At the Start of mirror plane prompt, in the Front viewport snap to the one end of the handle
edge.

4 At the End of mirror plane prompt, toggle ortho on and pick a point to the right in the Front
viewport.

5 Join the two surfaces together.

6 From the Solid menu, click Cap Planar Holes.

7 At the Select surfaces or polysurfaces to cap prompt, choose the handle.
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8 At the Select surfaces or polysurfaces to cap prompt, press ENTER.

9 Save your model.

To create the hole for the handle:

1 Draw a Circle with the center .88 from the end of the handle.  You may have to draw a
construction line to help you position the circle.

2 From the Surface menu, click Extrude, then click Straight.

3 At the Extrusion distance <2.00> (Direction Cap=yes Bothsides Tapered) prompt, type B
and press ENTER.

4 At the Extrusion distance (Direction Cap=yes) prompt, type 2 and press ENTER.

5 Use Difference to remove the cylinder from the handle.
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6 Save your model.

To create the fillets for the hole:

1 From the Solid menu, click Fillet Edge.

2 At the Select edges to fillet ( Radius=0.1 ) prompt, type .1 and press ENTER.

3 At the Select edges to fillet ( Radius=0.1 ) prompt, select both edges of the hole.

4 At the Select edges to fillet ( Radius=0.1 ) prompt, press ENTER.

The edge has a round on them.

5 Save your model.

6 Click in the Perspective viewport.

7 From the Render menu, click Shade.
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8 From the Render menu, click Render.


